
EXERCISES-MEASURING IFFS USING PARTNER COUNTRY-PCM AND 
PRICE FILTER-PFM METHODS 
 
PCM 
STEPS 

1. Use the Tax Jus�ce Network pla�orm on country vulnerability, intensity and exposure 
to IFFs to analyse for commodi�es and countries of des�na�on cons�tu�ng the 
highest IFFs risks to your country 

2. Select one commodity to measure for a year 
3. Iden�fy country of des�na�on 
4. Retrieve export data from expor�ng country 
5. Retrieve import data from impor�ng country 
6. Compare their values 
7. Adjust for transport 
8. Adjust for insurance 
9. Adjust for mark-up 
10. Establish the threshold where you will say the difference is abnormal and thus IFF 
11. Summary grand totals of inflows and ou�lows. 

 
Excel Implementa�on of PCM: 
Modeling PCM for Ghana 
I. Objec�ves:  
a. Es�mate the difference between country A ’s reported export to its partner countries 
(Ghana_X.xlsx) and Partner countries’ reported import from country A (Partner_M.xlsx) 
b. Es�mate the difference between country A’s reported import from its partner 
countries (Ghana_M.xlsx) and Partner countries’ reported export to country A 
(Partner_X.xlsx) 
c. Iden�fy top 10 or 20 high-risk countries with misinvoicing in export and import 
 
II. Data source: IMF DOTS, 2012 monthly. 
 
Modeling steps: 
 

I.Complica�on:  
The list of partner countries reported by Ghana does not match the partner countries 
which reported having trade (export or import) with Ghana. 
Illustra�on:  



II.Ghana’s export list of partner countries: A, B, C, D 
III.List of Countries reported as having imported from Ghana: A, B, D, E. 
IV.For Country C, Ghana reported as having exported but Country C did not report any 

import from Ghana 
V.For Country E, Ghana has no record of having exported to E, but E reported as having 

imported from Ghana 
VI.To put together all the data from Ghana’s export and Partners’ import, we need to 

create a list of all countries: A, B, C, D, and E: Name the file as 
PCM_Ghana_X_Analysis.xlsx (PCM_Ghana_M_Analysis.xlsx for import analysis.) This 
file has only one column with a list of all the countries, A, B, C, D, E. 

VII.Using Power Pivot in Excel, build a model rela�ng PCM_Ghana_X_Analysis.xlsx to 
Ghana_X_2012.xlsx and Partner_M_2012.xlsx and create calculated fields: 

i. Export_Over_Invoiced_amount =  MAX(0, (Ghana_X – 
Partner_M/1.1)) 

ii. Export_Under_Invoiced_amount = MAX(0,(Partner_M/1.1 – 
Ghana_X)) 

iii. Dividing import data by a factor of 1.1 is because import data is 
reported as CIF while export data as FOB. 

 

VIII.Modeling PCM using Power Pivot for Ghana Export misinvoicing 
IX.Open a new Excel blank workbook. Save it as =xlsx  

(If Power Pivot is not ac�vated, ac�vate Power Pivot:  File > Op�ons > Add-ins > 
Select “Microso� Power Pivot for Excel” from Inac�ve Applica�on Add-ins list) 

X.Click “Power Pivot” from the ribbon 

XI.Click Manage 

 



XII.To import Ghana_X_2012.xlsx data, select “From Other Sources” from “Get External 
Data” group 

XIII.You will see a list of Rela�onal Databases. Scroll through to the botom of the list. 
Select Excel File (or Text File for impor�ng a CSV file) > Browse > & check “Use first row 
as column headers” > Next > Finish (name the table as Ghana_X) 

XIV.Repeat to import Partner_M_2012.xlsx (name the table as Partner_M) and 
PCM_Ghana_X_Analysis.xlsx (name the table as Ghana_X_IFF) 

XV.Click “Diagram View”  in View Group 

XVI.Then you will see three tables 

 
 

XVII.At this point, three tables are not related to each other. To model the rela�on between 
Ghana_X_IFF and Ghana_X, drag the field, “Partner” from Ghana_X_IFF to “Partner” 
in Ghana_X. Repeat this process for Partner in Ghana_X_IFF to Reporter in Partner_M . 

XVIII.There should be lines linking tables. At the ends of the lines, a “*” should be on the 
side of Ghana_X_IFF table and a “1” on Ghana_X and Partner_M. This indicates one-
to-many rela�ons. 
 



XIX.Now click “Data View” in the View group: 

 
 

 
You should see a list of three tables at 
the botom: Ghana_X, Partner_M, 
Ghana_X_IFF. Above Ghana_X_IFF, 
only one table heading (field name) is 
shown: Partner.  
Inser�ng Calculated Fields 
Double click the heading “Add 
Column” on the top right-hand side, 
and you can name a new field name 
to be calculated. Name it as Ghana_X. 
Add three more columns: Partner_X, 
Ghana_X_Over, Ghana_X_Under. 
No�ce the calculated fields are 
highlighted in black. 
 
Now put a formula for each calculated 
field: 
Start with Ghana_X: 
- Click the heading 
- Type “=” and con�nue type 
“related(" > select the field 
“Ghana_X[G_X_2012] > type with a 
closing parenthesis “)”. No�ce the 
column will be populated with the 

export data from Ghana_X table. 
- Repeat the same procedure for Partner_M field, 

“=Related(Partner_M[_P_M_2012])” 
 
 



- Now put a formula for Ghana_X_Over as:  
 “=max(0,Ghana_X_IFF[Ghana_X]-Ghana_X_IFF[Partner_M]/1.1)” 

 

For easy reading, the numbers may be formated as $ with no decimals.  
This completes the Ghana’s Export overinvoicing and Export under-invoicing calcula�on. 
 

XX.Create Pivot Table to sort by IFF amount and iden�fy high-risk 
partners 

 
 

XXII.Select the field “Partner” from Ghana_X_IFF, then Ghana_X_ov, Ghana_X_un 
 



 
 

XXIII.Select the en�re pivot table and copy it. 
XXIV.Paste it in a range somewhere below the pivot table: Click Home > Paste (down arrow) 

> Select “Values (V)”  from “Paste Values” group 
XXV.To find the list of top 10 (or 20) high risk countries with Export Underinvoicing, sort 

the table in descending order of Ghana_X_un.  
 

XXVI.To find the list of top 10 (or 20) high risk countries with Export Overinvoicing, sort the 
table in descending order of Ghana_X_ov.  
 

XXVII.Modeling PCM using Power Pivot for Ghana Import misinvoicing 

For Ghana’s Import analysis, follow the same process as in “IV. 
Modeling PCM using Power Pivot for Ghana Export misinvoicing” 
and “V. Create Pivot Table to sort by IFF amount and iden�fy high-
risk partners.” 

Price Filter Method-PFM 
1. Use Tax Jus�ce Network pla�orm and analyse for the commodi�es and countries of 

des�na�ons with the highest risks of mispricing 
2. Iden�fy one commodity you want to analyse for a year 
3. Consolidate the commodity values for one year 



4. Determine whether the commodity has established market price or not. 
5. If commodity has established market price, then use market prices to compare with 

declared values by trader 
6. Treat the established market price as the Arm’s Length price 
7. Determine the threshold values below and above this arm’s length price 
8. Consolidate the under-invoiced amounts for a year 
9. Consolidate the over-invoiced amounts for a year 
10. If there is no established market price for the commodity, then use a sta�s�cal 

method to es�mate an arm’s length price 
11. Treat this as the arm’s length price 
12. Compare this arm’s length price to the declared values 
13. Determine which values are above(under-invoicing) and which are below (over-

invoicing) the arm’s length price 
14. Consolidate under-invoiced amount for a year 
15. Consolidate the over-invoiced amount for a year 
16. Iden�fy individual businesses with the highest risks 
17. Iden�fy the countries of des�na�on for commodi�es with highest risks(top 10 to 20) 
18. Iden�fy commodi�es with the highest risks(top 10 to 20) 

 
Excel Implementa�on of PFM 
Modeling PFM US Export to Country A (Ghana, Liberia, Nigeria or Sierra Leone) 
I. Objectives:  
a. Estimate the overinvoiced amount (amt_ov_w) and the underinvoiced amount 
(amt_un_w) in the U.S. export data using a US-World Price filters (upper quartile price 
“PUpQ” and lower quartile price “PUpQ”). Amt_ov_w = MAX(0, (price – 
PUpQ)*Quantity) Amt_un_w= MAX(0,(PLoQ – price)*Quantity) 
b. Identify top 10 or 20 high-risk commodity groups (by HS10 and HS02) 
II. Data source: US Merchandise Trade: Exports – Monthly (2012) Web: 
https://www.census.gov/foreign-trade/statistics/dataproducts/index.html 
 

XXVIII.Complica�on:  
The US Export data (US_Exp_toGhana2012.xlsx) include several fields: HS10 code 
(commodity), country code (cty_code), quan�ty (all_qy1_mo), and value (all_val_mo). 
The commodity names are on a separate reference table (hs10x12.xlsx). HS02 code can 
be extracted from HS10, but it also needs a reference table for HS02 (HS02.xlsx). The 
price filters are on its own table (MTX1212X_Wrld.xlsx based on US-World trade records 
and MTX1212X_Ghana.xlsx based on US-Ghana trade records.) 
 
It is necessary to model rela�ng the US Export data (US_Exp_toGhana2012.xlsx) table to 
four other tables. This requires using a rela�onal database tool. The Power Pivot in Excel 
is used in this exercise.  Other tools such as Microso� SQL Server, Oracle Database, 
MySQL, IBM DB2, and PostgreSQL are more efficient but has significant steep learning 
curve compared to Excel Power Pivot. 

https://www.census.gov/foreign-trade/statistics/dataproducts/index.html


 

XXIX.Modeling PFM using Power Pivot for Ghana Export misinvoicing 
XXX.Open a new Excel blank workbook. Save it as PFM_US_X_to_Ghana.xlsx  

(If Power Pivot is not ac�vated, ac�vate Power Pivot:  File > Op�ons > Add-ins > 
Select “Microso� Power Pivot for Excel” from Inac�ve Applica�on Add-ins list) 

XXXI.Click “Power Pivot” from the ribbon 

XXXII.Click Manage 

 



XXXIII.To import US_Exp_toGhana2012.xlsx data, select “From Other Sources” from “Get 
External Data” group 

XXXIV.You will see a list of Rela�onal Databases. Scroll through to the botom of the list. 
Select Excel File (or Text File for impor�ng a CSV file) > Browse > & check “Use first row 
as column headers” > Next > Finish (name the table as Exp12toGhana) 

XXXV.Repeat to import MTX1212X_Wrld.xlsx (name the table as MTX1212X_Wrld), 
MTX1212X_Ghana.xlsx (name the table as MTX1212X_Ghan), hs10x12.xlsx (name the 
table as hs10x12), and hs02.xlsx (name the table as hs02) 

XXXVI.Click “Diagram View”  in View Group 

XXXVII.Then you will see five tables.  Link fields from tables to model/create the rela�ons as 
follows: 
 

Commodity in Exp12toGhana  
 commodity in hs10x02 

1.  hs10 in MTX1212X_Wrld  
2. hs10 in MTX1212X_Ghana 
 HS2 in Exp12toGhana  commodity in hs02 



Here is the diagram view of the completed model: 

 
 

XXXVIII.Now click “Data View” in the View group: 

 
 

 
You should see a list of five tables at the botom: Exp12toGhana, 
MTX1212X_Wrld, MTX1212X_Ghana, hs10x12, hs02. 

 
XXXIX.Inser�ng Calculated Fields 

Go to the table, “Exp12toGhana” 
Double click the heading “Add Column” on the top right-hand side, and you can 
name a new field name to be calculated. Name it as price. Add six more 
columns: PLoQ_W, PUpQ_W, amt_un_w, amt_ov_w, descript_2, 
HS2_Descrip�on. No�ce the calculated fields are highlighted in black. 

 
Now put a formula for each calculated field: 
Start with price: 

- Click the heading 
- Type “=” and con�nue type  

“=if(Exp12toGhana[all_qy1_mo]>0,Exp12toGhana[all_val_mo]/Exp12toGhana[all_qy1_mo],0
)” 
 

- Repeat the same procedure for the remaining fields: 



- PLoQ_W: “=IF(ISBLANK(RELATED(MTX1212X_Wrld[ploq])), 
0,RELATED(MTX1212X_Wrld[ploq])) 

- PUpQ_W: “=IF(ISBLANK(RELATED(MTX1212X_Wrld[pupq])),0, 
RELATED(MTX1212X_Wrld[pupq]))” 

- amt_un_w: “=max(0,(Exp12toGhana[PLoQ_W] - Exp12toGhana[price])* 
Exp12toGhana[all_qy1_mo])” 

- amt_ov_w: “=max(0,(Exp12toGhana[price]-Exp12toGhana[PUpQ_W])* 
Exp12toGhana[all_qy1_mo])”  

- descript_2: “=RELATED(hs10x12[descrip_2])”  (comment: This is HS10 descrip�on) 
- HS2_Descrip�on: “=RELATED(hs02[abbreviatn])” 
 
For easy reading, the numbers may be formated as $ with two decimals for price fields, 
no decimals for amount fields.  

 
 
 

XL.Create Pivot Table to sort by IFF amount and iden�fy high-risk HS10 
commodity groups 

XLI.PivotTable dropdown menu: Select Pivot Table > Choose “New Worksheet” 

 
 



 
XLII. Select the field “Descrip_2” from 

Exp12toGhana table 
- Then select three more fields from the 
same table: all_val_mo, amt_un_w, amt_ov_w 

XLIII. Select the en�re pivot table and copy 
it. 

XLIV. Paste it in a range somewhere below 
the pivot table: Click Home > Paste (down 
arrow) > Select “Values (V)” from “Paste 
Values” group 

XLV. To find the list of top 10 (or 20) high 
risk commodi�es (at HS10 level) with 
Export Underinvoicing, sort the table in 
descending order of amt_un_w.  

XLVI. To find the list of top 10 (or 20) high 
risk commodi�es (at HS10 level) with 
Export Overinvoicing, sort the table in 
descending order of amt_ov_w.  
 

This completes the PFM model for Ghana Export mispricing based on the US-World Price 
filter. 
 
By using MTX1212X_Ghana, you can create a PFM model for Ghana Export mispricing based 
on the US-Ghana Price filter. 
 

XLVII.Modeling PFM using Power Pivot for Ghana Import misinvoicing 

For Ghana’s Import PFM analysis, follow the same process as in 
above steps “IV” and “V.” 

      Files for tables: 
- US_Imp_fromGhana2012.xlsx 
- MTX1212M_Wrld.xlsx  (comment: Import commodity classifica�on is different from 

Export commodity classifica�on) 
- MTX1212M_GHANA.xlsx 
- hs10m12.xlsx 
- hs02.xlsx 

XLVIII.Final Note 
- The data files, US_Imp_fromGhana2012.xlsx and US_Exp_fromGhana2012.xlsx, are 

extracted US import from Ghana and US export to Ghana from US Import data file 
and US Export data file, respec�vely. 



- The price matrix files (MTX1212X_Wrld.xlsx, MTX1212X_Ghana.xlsx, 
MTX1212M_Wrld.xlsx, MTX1212M_Ghana.xlsx) are originally created using a 
rela�onal database program from export and import records.  

- In this exercise, there were substan�al amount of manual processing. However, the 
en�re exercise in session 10 can be automated using a rela�onal database program 
star�ng from raw data at transac�on level. The Power Pivot in Excel helps us 
understand the concept of rela�onal database model building and create calculated 
fields of interest. 
 

(Datasets prepared by Dr Simon Pak from USA and Ghana data(supplied by ISODEC) 



GSS/ISODEC TRAINING ON 
MEASURING IFFS FOR GHANA, 
LIBERIA, NIGERIA AND SIERRA 

LEONE
MONITORING PAYMENTS OF ROYALTIES, WITHOLDING TAXES, 

MANAEMENT FEES, LOAN INTEREST, ETC
(Bishop Akolgo-IFFs Consultant)



STEPS AND METRICS FOR MONITORING MNEs
• To monitor payments of royalties, withholding taxes, management fees, loan interests, and other financial 

transactions related to your MNE (Multinational Enterprise), you should follow these steps:

• Establish a centralized system: Create a centralized system to manage all financial transactions related 
to your MNE. This system should be accessible to all stakeholders involved in financial transactions, 
including your MNE’s financial team, auditors, tax authorities, and other relevant parties.

• Use accounting software: Use accounting software to track all financial transactions related to your 
MNE. This software should be able to record, process, and report financial transactions, including 
payments of royalties, withholding taxes, management fees, loan interests, and other expenses.

• Implement controls: Implement controls to ensure that all financial transactions are recorded accurately 
and on time. This includes implementing internal controls to prevent fraud and errors in financial 
reporting.

• Hire experts: Hire experts in tax, accounting, and finance to oversee financial transactions related to 
your MNE. These experts can help ensure compliance with local tax laws and regulations and provide 
guidance on financial reporting.

• Monitor compliance: Monitor compliance with local tax laws and regulations to ensure that your MNE is 
paying the correct amount of taxes and royalties. This includes staying up-to-date on changes in tax laws 
and regulations and regularly reviewing financial statements.

• Conduct audits: Conduct regular audits of your MNE’s financial transactions to ensure that they are 
accurate and comply with local tax laws and regulations. This can help identify areas for improvement and 
prevent financial errors and fraud



WHAT METRICS FOR MONITORING MNEs?
• Here are some metrics that you(TPU) can use to monitor and conduct regular audits of your MNE's 

financial transactions:

• Gross margin: This metric represents the difference between your MNE's revenue and cost of 
goods sold. It can help you evaluate the profitability of your MNE's operations and identify areas 
for improvement.

• Return on investment (ROI): ROI measures the return on investment for a particular financial 
transaction. It can help you evaluate the effectiveness of your MNE's investments and identify areas 
where the return is not meeting expectations.

• Accounts receivable turnover: This metric represents the number of times your MNE collects its 
average accounts receivable balance during a given period. It can help you evaluate the efficiency 
of your MNE's collections process and identify areas for improvement.

• Inventory turnover: This metric represents the number of times your MNE sells and replaces its 
inventory during a given period. It can help you evaluate the efficiency of your MNE's inventory 
management and identify areas for improvement.

• Operating cash flow: Operating cash flow measures the cash generated or used by your MNE's 
operations. It can help you evaluate the ability of your MNE to generate cash from its core 
operations and identify areas where cash flow may be improving or declining.



MERICS FOR MONITORING MNEs CONTINUED
1. Revenue growth: This metric measures the increase or decrease in your MNE's revenue over time. 

A steady or increasing revenue growth rate can indicate a healthy financial position, while a 
declining rate can signal issues that need to be addressed.

2. Profitability: This metric measures your MNE's ability to generate profits from its operations. It can 
be measured in terms of gross profit margin, operating profit margin, or net profit margin. A 
healthy profit margin indicates that your MNE is efficiently managing its costs and generating 
revenue.

3. Cash flow: This metric measures the amount of cash that your MNE generates or uses in its 
operations. Positive cash flow indicates that your MNE has enough cash to cover its expenses, 
invest in growth opportunities, and pay dividends to shareholders.

4. Debt-to-equity ratio: This metric measures the proportion of debt and equity financing that your 
MNE is using. A high debt-to-equity ratio indicates that your MNE may be taking on too much 
debt and may be at risk of defaulting on its loans.

5. Return on investment (ROI): This metric measures the return that your MNE generates from its 
investments. A high ROI indicates that your MNE is generating value from its investments and is 
effectively allocating its resources.

6. Compliance with tax laws and regulations: This metric measures your MNE's compliance with 
local tax laws and regulations. It can be measured in terms of the accuracy and completeness of 
your MNE's tax filings, as well as its ability to pay taxes on time.



WHAT SYSTEM NEEDS TO BE IN PLACE TO MONITOR MNEs?
• Automating financial monitoring and auditing processes can save time and reduce errors in financial 

reporting. Python is a popular programming language that can be used for financial analysis and 
automation. Here are some steps you can take to automate financial monitoring and auditing using 
Python:

1. Connect to your financial data sources: Depending on the sources of your financial data, you may 
need to connect to databases, APIs, or file systems. Python has many libraries that can be used to 
connect to different data sources, such as pandas, SQLAlchemy, and Pyodbc.

2. Extract and clean your financial data: Once you have connected to your data sources, you can use 
Python to extract and clean your financial data. For example, you can use pandas to read and clean data 
from Excel files or SQL databases.

3. Calculate financial metrics: After cleaning your financial data, you can use Python to calculate financial 
metrics such as revenue growth, profitability, and cash flow. You can write custom functions to calculate 
these metrics or use pre-built functions from libraries such as NumPy and SciPy.

4. Visualize your financial data: Python has several libraries for data visualization, such as Matplotlib and 
Seaborn. You can use these libraries to create charts and graphs to visualize your financial metrics and 
identify trends.

• Set up automated reporting and alerting: You can use Python to automate financial reporting and 
alerting. For example, you can set up a script to generate daily or weekly reports on your financial metrics 
and send them to stakeholders via email or Slack. You can also set up alerts to notify you when certain 
metrics fall outside of acceptable ranges.



Guide to Modeling PCM for Ghana 
File: Lesson 9: PCM-PowerPivot-Ghana2012_Analysis_v1.xlsx 
 

I. Objectives:  
a. Estimate the difference between Ghana’s reported export to its partner countries 

(Ghana_X.xlsx) and Partner countries’ reported import from Ghana (Partner_M.xlsx) 
b. Estimate the difference between Ghana’s reported import from its partner countries 

(Ghana_M.xlsx) and Partner countries’ reported export to Ghana (Partner_X.xlsx) 
c. Identify top 10 or 20 high-risk countries with misinvoicing in export and import 

 
II. Data source: IMF DOTS, 2012 monthly. 

 
III. Complication:  

The list of partner countries reported by Ghana does not match the partner countries which 
reported having trade (export or import) with Ghana. 
Illustration:  
a. Ghana’s export list of partner countries: A, B, C, D 
b. List of Countries reported as having imported from Ghana: A, B, D, E. 
c. For Country C, Ghana reported as having exported but Country C did not report any 

import from Ghana 
d. For Country E, Ghana has no record of having exported to E, but E reported as having 

imported from Ghana 
e. To put together all the data from Ghana’s export and Partners’ import, we need to 

create a list of all countries: A, B, C, D, and E: Name the file as 
PCM_Ghana_X_Analysis.xlsx (PCM_Ghana_M_Analysis.xlsx for import analysis.) This 
file has only one column with a list of all the countries, A, B, C, D, E. 

f. Using Power Pivot in Excel, build a model relating PCM_Ghana_X_Analysis.xlsx to 
Ghana_X_2012.xlsx and Partner_M_2012.xlsx and create calculated fields: 

i. Export_Over_Invoiced_amount =  MAX(0, (Ghana_X – Partner_M/1.1)) 
ii. Export_Under_Invoiced_amount = MAX(0,(Partner_M/1.1 – Ghana_X)) 

iii. Dividing import data by a factor of 1.1 is because import data is reported as CIF 
while export data as FOB. 

 
IV. Modeling PCM using Power Pivot for Ghana Export misinvoicing 

a. Open a new Excel blank workbook. Save it as =xlsx  
(If Power Pivot is not activated, activate Power Pivot:  File > Options > Add-ins > Select 
“Microsoft Power Pivot for Excel” from Inactive Application Add-ins list) 

b. Click “Power Pivot” from the ribbon 



c. Click Manage 

 
d. To import Ghana_X_2012.xlsx data, select “From Other Sources” from “Get External 

Data” group 

e. You will see a list of Relational Databases. Scroll through to the bottom of the list. Select 
Excel File (or Text File for importing a CSV file) > Browse > & check “Use first row as 
column headers” > Next > Finish (name the table as Ghana_X) 

f. Repeat to import Partner_M_2012.xlsx (name the table as Partner_M) and 
PCM_Ghana_X_Analysis.xlsx (name the table as Ghana_X_IFF) 

g. Click “Diagram View”  in View Group 

h. Then you will see three tables 



 
 

i. At this point, three tables are not related to each other. To model the relation between 
Ghana_X_IFF and Ghana_X, drag the field, “Partner” from Ghana_X_IFF to “Partner” in 
Ghana_X. Repeat this process for Partner in Ghana_X_IFF to Reporter in Partner_M . 

j. There should be lines linking tables. At the ends of the lines, a “*” should be on the side 
of Ghana_X_IFF table and a “1” on Ghana_X and Partner_M. This indicates one-to-many 
relations. 

 

k. Now click “Data View” in the View group: 

 
 



 
You should see a list of three tables at the 
bottom: Ghana_X, Partner_M, 
Ghana_X_IFF. Above Ghana_X_IFF, only one 
table heading (field name) is shown: 
Partner.  
Inserting Calculated Fields 
Double click the heading “Add Column” on 
the top right-hand side, and you can name a 
new field name to be calculated. Name it as 
Ghana_X. Add three more columns: 
Partner_X, Ghana_X_Over, 
Ghana_X_Under. Notice the calculated 
fields are highlighted in black. 
 
Now put a formula for each calculated field: 
Start with Ghana_X: 
- Click the heading 
- Type “=” and continue type 
“related(" > select the field 
“Ghana_X[G_X_2012] > type with a closing 
parenthesis “)”. Notice the column will be 
populated with the export data from 
Ghana_X table. 
- Repeat the same procedure for 
Partner_M field, 
“=Related(Partner_M[_P_M_2012])” 

 
 

- Now put a formula for Ghana_X_Over as:  
 “=max(0,Ghana_X_IFF[Ghana_X]-Ghana_X_IFF[Partner_M]/1.1)” 

- Repeat for Ghana_X_Under “=max(0,Ghana_X_IFF[Partner_M]/1.1-Ghana_X_IFF[Ghana_X])” 



 

For easy reading, the numbers may be formatted as $ with no decimals.  
This completes the Ghana’s Export overinvoicing and Export under-invoicing calculation. 
 

V. Create Pivot Table to sort by IFF amount and identify high-risk partners 
a. PivotTable dropdown menu: Select Pivot Table > Choose “New Worksheet” 

 

 
b. Select the field “Partner” from Ghana_X_IFF, then Ghana_X_ov, Ghana_X_un 

 



 
 

c. Select the entire pivot table and copy it. 
d. Paste it in a range somewhere below the pivot table: Click Home > Paste (down arrow) > 

Select “Values (V)”  from “Paste Values” group 
e. To find the list of top 10 (or 20) high risk countries with Export Underinvoicing, sort the 

table in descending order of Ghana_X_un.  
 

f. To find the list of top 10 (or 20) high risk countries with Export Overinvoicing, sort the 
table in descending order of Ghana_X_ov.  

 
VI. Modeling PCM using Power Pivot for Ghana Import misinvoicing 

For Ghana’s Import analysis, follow the same process as in “IV. Modeling PCM using Power 
Pivot for Ghana Export misinvoicing” and “V. Create Pivot Table to sort by IFF amount and 
identify high-risk partners.” 

 
 

 This file directory/FileName: 
 G:\Ghana2021\Worshop\Session09_PCM_PowerPivot\PCM-PowerPivot-Ghana2012_Analysis_v1.docx 

 



GSS/ISODEC TRAINING 
WORKSHOP ON MEASURING 

IFFS IN WEST AFRICA
REAL-TIME MONITORING OF IFFS IN TAX AND COMMERCIAL ACTIVITIES-TRADE, BANKING, FINANCE 

AND INVESTMENTS

(Bishop Akolgo-IFFs Consultant-Researcher and Trainer)
(See crude Qt6 model for CPA and K-Means analysis of the six methods)



GENERALLY, DATA, PROCESS AND INTERFACE
• Load the trade data: Load the data on imports and exports from various sources into a DataFrame. These 

sources could include customs data, trade statistics from government agencies, or other public databases.
• Preprocess the data: Clean the data by removing any missing or erroneous values, and then group the data 

by country and product.
• Calculate reference prices: Calculate reference prices for each product based on the prices of similar 

products from other countries. This can help to identify anomalies in prices for a given product (proxy for 
arm’s length price using market prices or statistical method to get the proxy price).

• Calculate mispricing indicators: Calculate mispricing indicators for each product, such as the ratio of the 
import price to the reference price. This can help to identify instances of over-invoicing or under-invoicing.

• Aggregate results: Aggregate the results by country and product to identify which countries and products 
are most affected by trade mispricing.

• Visualize the results: Visualize the results using charts, graphs, and tables to make it easier to identify 
patterns and trends in the data.

• Provide a user interface: Provide a user interface that allows users to upload their own trade data, select the 
countries and products they want to analyze, and view the results in an easy-to-understand format.

• Add features: Add features such as the ability to compare trade data across multiple time periods, or to filter 
the data based on specific criteria, such as the value or volume of trade, trade concentration, etc..

• Add machine learning: Consider adding machine learning techniques to the model to improve its accuracy 
and to identify patterns that might be difficult to detect using traditional statistical methods.



WHAT MODEL FOR REAL-TIME MONITORING OF IFFS?
• There are several machine learning models that could be used for continuous monitoring of trade mis-

pricing, BEPs, debt/asset shifting, transfer-pricing, etc. Some of these models are:

• Supervised learning models: Supervised learning models can be used to predict whether a transaction is 
likely to be a case of transfer pricing or mis-pricing based on the historical data of such cases. Some popular 
supervised learning models that could be used are logistic regression, decision trees, random forests, and 
support vector machines.

• Unsupervised learning models: Unsupervised learning models can be used to cluster similar transactions 
and identify outliers that could be potential cases of mis-pricing or transfer pricing. Some popular 
unsupervised learning models that could be used are k-means clustering, hierarchical clustering, and 
principal component analysis.

• Deep learning models: Deep learning models can be used to identify patterns and anomalies in the data 
that may not be apparent to other models. Some popular deep learning models that could be used are 
convolutional neural networks (CNNs), recurrent neural networks (RNNs), and deep belief networks (DBNs).

• Ensemble learning models: Ensemble learning models can be used to combine the predictions of multiple 
models to improve accuracy and reduce bias. Some popular ensemble learning models that could be used 
are bagging, boosting, and stacking.



OTHER REQUIREMENTS TO MONITOR IFFS IN REAL-TIME
• In addition to the machine learning models, it is also important to have a data 

management system in place to ensure that the data is accurate, complete, and 
up-to-date. 

• This could involve implementing data quality checks, data cleansing, and data 
normalization procedures.

• Furthermore, it is important to have a team of commodity experts and experts 
with a deep understanding of transfer pricing rules, tax regulations, and 
international trade laws to ensure that the outputs of the machine learning 
models are properly interpreted and acted upon.



TRADE MIS-PRICING
• For real-time monitoring of under-invoicing and over-invoicing in import and export trade, a possible 

machine learning model that can be used is Anomaly Detection. 

• This model can identify outliers or anomalies in the data that may indicate fraudulent invoicing or mis-
pricing.

• One approach for implementing an anomaly detection model in Python is to use the Isolation Forest 
algorithm. 

• This algorithm is a tree-based ensemble method that can efficiently detect outliers in high-dimensional data
• First load the invoice data into a Pandas DataFrame and extract the relevant features from the data (price, 

quantity, country, and HS code). Then train the Isolation Forest model on the features and predict the 
anomalies in the data using the predict() method. 

• Finally, print the indices of the anomalous invoices using the .index attribute of the DataFrame.

• Note that the n_estimators, max_samples, and contamination parameters of the Isolation Forest model can 
be tuned to optimize the performance of the model for a given dataset. 

• Additionally, other anomaly detection algorithms such as Local Outlier Factor or One-class SVM could also 
be considered depending on the specific use case.

•



BASE EROSION AND PROFIT-SHIFTING-BEPS
• To monitor BEPs and transfer-pricing, one approach is to use a regression-based model that can predict the expected 

price or profit margin for a given product or transaction, based on relevant features such as the description of goods, HS 
codes, destination countries, and historical transaction data.

• A possible regression-based model that could be used is a linear regression model or a decision tree regression model. 

• The model can be trained on historical data with known prices and profit margins, and then used to predict the expected 
prices and profit margins for new transactions. 

• The predicted prices and profit margins can then be compared to the actual prices and profit margins to identify potential 
cases of BEPs or transfer-pricing.

• first load the historical data into a Pandas DataFrame and extract the relevant features from the data (description, HS 
code, price, quantity, and destination country). Then split the data into training and test sets using the train_test_split() 
function from scikit-learn. Next, train the decision tree regression model on the training set and predict the prices for the 
test set using the predict() method. Finally, evaluate the performance of the model on the test set using the R-squared 
score, which measures the proportion of variance in the actual prices that can be explained by the predicted prices.

• Note that the performance of the model can be further improved by tuning the hyperparameters of the decision tree 
regression model using techniques such as grid search or random search. Additionally, it is important to use high-quality 
data and carefully select the relevant features to ensure that the model is accurately capturing the underlying patterns in 
the data.



DEBT AND ASSET SHIFTING BY MNEs
• To monitor debt and asset shifting by multinational enterprises (MNEs), one approach is to use a 

classification-based model that can predict whether a transaction or investment is likely to involve debt or 
asset shifting, based on relevant features such as the type of transaction, the involved countries, and the 
financial information of the MNE.

• A possible classification-based model that could be used is a logistic regression model or a decision tree 
classification model. 

• The model can be trained on historical data with known instances of debt and asset shifting, and then used 
to predict the likelihood of debt and asset shifting for new transactions or investments.

• First, load the historical data into a Pandas DataFrame and extract the relevant features from the data 
(transaction type, country, and financial information of the MNE). Then convert the categorical features to 
numerical features using one-hot encoding, and split the data into training and test sets using the 
train_test_split() function from scikit-learn. Next, train the logistic regression model on the training set and 
predict the classes for the test set using the predict() method. Finally, evaluate the performance of the 
model on the test set using the accuracy score, which measures the proportion of correctly classified 
instances.

• Note that the performance of the model can be further improved by tuning the hyperparameters of the 
logistic regression model using techniques such as grid search or random search. Additionally, it is important 
to use high-quality data and carefully select the relevant features to ensure that the model is accurately 
capturing the underlying patterns in the data.



FLOWS OF OFFSHORE FINANCIAL WEALTH BY COUNTRY
• To monitor flows of offshore financial wealth by country, one approach is to use a regression-based model that can 

predict the amount of offshore financial wealth held by a country, based on relevant features such as the country's 
economic and political indicators, the presence of offshore financial centers, and the policies and regulations 
related to offshore financial activities.

• A possible regression-based model that could be used is a multiple linear regression model or a random forest 
regression model. The model can be trained on historical data with known amounts of offshore financial wealth, 
and then used to predict the amount of offshore financial wealth for new countries.

• First,  load the historical data into a Pandas DataFrame and extract the relevant features from the data (economic 
and political indicators, presence of offshore financial centers, and policies and regulations related to offshore 
financial activities). Then convert the categorical features to numerical features using one-hot encoding, and split 
the data into training and test sets using the train_test_split() function from scikit-learn. Next, we train the linear 
regression model on the training set and predict the amount of offshore financial wealth for the test set using the 
predict() method. 

• Finally, evaluate the performance of the model on the test set using the R-squared score, which measures the 
proportion of variance in the target variable that is explained by the model.

• Note that the performance of the model can be further improved by incorporating additional features and tuning 
the hyperparameters of the regression model using techniques such as cross-validation or regularization. 
Additionally, it is important to use high-quality data and carefully select the relevant features to ensure that the 
model is accurately capturing the underlying patterns in the data.



TRANSFER OF WEALTH TO AVOID TAX BY INDIVIDUALS

• To monitor transfer of wealth by individuals to avoid tax, one approach is to use a machine learning model that can 
predict the likelihood of tax evasion based on relevant features such as income, assets, investments, expenditures, 
and other financial indicators. The model can be trained on historical data with known instances of tax evasion, 
and then used to identify high-risk individuals who may be engaging in tax evasion.

• A possible machine learning model that could be used is a binary classification model such as logistic regression or 
a decision tree classifier. The model can be trained on a labeled dataset with examples of both non-evasive and 
evasive individuals, and then used to predict the probability of tax evasion for new individuals.

• First, load the labeled data into a Pandas DataFrame and extract the relevant features from the data (income, 
assets, investments, and expenditures). Then convert the categorical features to numerical features using one-hot 
encoding, and split the data into training and test sets using the train_test_split() function from scikit-learn. Next, 
we train the logistic regression model on the training set and predict the likelihood of tax evasion for the test set 
using the predict() method. Finally, evaluate the performance of the model on the test set using the confusion 
matrix and classification report, which provide information about the model's accuracy, precision, recall, and F1 
score.

• Note that the performance of the model can be further improved by incorporating additional features and tuning 
the hyperparameters of the logistic regression model using techniques such as cross-validation or regularization. 
Additionally, it is important to use high-quality data and carefully select the relevant features to ensure that the 
model is accurately capturing the underlying patterns in the data.



MNE vs comparable non-MNE Profit-Shifting
• To monitor profit shifting by MNEs compared to comparable non-MNEs, one approach is to use a machine learning 

model that can predict the likelihood of profit shifting based on relevant features such as transfer pricing, 
intercompany transactions, and other financial indicators. The model can be trained on historical data with known 
instances of profit shifting by MNEs and comparable non-MNEs, and then used to identify high-risk MNEs that may 
be engaging in profit shifting.

• A possible machine learning model that could be used is a binary classification model such as logistic regression or 
a decision tree classifier. The model can be trained on a labeled dataset with examples of both MNEs and non-
MNEs, and then used to predict the probability of profit shifting for new MNEs.

• First, load the labeled data into a Pandas DataFrame and extract the relevant features from the data (transfer 
pricing, inter-company transactions, and other financial indicators). Then convert the categorical features to 
numerical features using one-hot encoding, and split the data into training and test sets using the train_test_split() 
function from scikit-learn. Next, train the logistic regression model on the training set and predict the likelihood of 
profit shifting for the test set using the predict() method. Finally, evaluate the performance of the model on the 
test set using the confusion matrix and classification report, which provide information about the model's 
accuracy, precision, recall, and F1 score.

• Note that the performance of the model can be further improved by incorporating additional features and tuning 
the hyperparameters of the logistic regression model using techniques such as cross-validation or regularization. 
Additionally, it is important to use high-quality data and carefully select the relevant features to ensure that the 
model is accurately capturing the underlying patterns in the data.



VULNERABILITY, INTENSITY AND EXPOSURE TO IFFS
• Assessing vulnerability, intensity, and exposure to illicit financial flows (IFFs) involves analyzing 

various economic, social, and political factors that contribute to the flow of illicit funds out of a 
country. This is a complex process that requires the use of multiple data sources and analytical tools. 
However, here are some possible steps and python packages that can be used for each component:

• Data collection: The first step is to collect data on the various factors that contribute to 
vulnerability, intensity, and exposure of a country to IFFs. Some of these factors might include 
corruption levels, tax evasion, money laundering, and weak regulatory frameworks. There are many 
sources of data available on the internet, including databases maintained by international 
organizations like the World Bank, IMF, and OECD.

• Data cleaning and processing: Once you have collected the data, you will need to clean and 
process it so that it can be used in your analysis. This might involve removing missing values, 
converting data into a common format, and standardizing units of measurement.

• Analysis: After cleaning and processing the data, you can start analyzing it using Python. There are 
many libraries available in Python for data analysis, including NumPy, Pandas, and SciPy. You can 
use these libraries to calculate various statistics, create visualizations, and perform regression 
analysis to identify the factors that contribute to vulnerability, intensity, and exposure to IFFs.

• Visualization: Finally, you can use Python to create visualizations of your data to help you 
communicate your findings. Libraries like Matplotlib and Seaborn are great for creating data 
visualizations.



POSSIBLE INDICATORS OF VULNERABILITY TO IFFS
• Here are some examples of indicators that could be used for each category:

1. Vulnerability:
• Corruption perception index (CPI), Ease of doing business index, Rule of law index, 

Political stability index, Financial secrecy index, Tax haven index, Export 
concentration index

2. Intensity:
• Size of the shadow economy, Tax revenue as a percentage of GDP,  Foreign direct 

investment (FDI) inflows, Gross capital outflows,  Money laundering cases and 
convictions, Suspicious transaction reports (STRs), Banking secrecy laws

3. Exposure:
• Trade openness index,  Import-export discrepancy index, Foreign currency reserves 

as a percentage of short-term debt, Debt-to-GDP ratio, Official development 
assistance (ODA) as a percentage of GDP, Natural resource dependence

• (Pls see the Tax Justice Network Platform for example implementation of above for your country)
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	Inserting Calculated Fields
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	XLI. PivotTable dropdown menu: Select Pivot Table > Choose “New Worksheet”
	XLII. Select the field “Descrip_2” from Exp12toGhana table
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	XLVIII. Final Note

	Monitoring MNEs Payment of royalties, fees, interest on loans
	GSS/ISODEC TRAINING ON MEASURING IFFS FOR GHANA, LIBERIA, NIGERIA AND SIERRA LEONE
	STEPS AND METRICS FOR MONITORING MNEs
	WHAT METRICS FOR MONITORING MNEs?
	MERICS FOR MONITORING MNEs CONTINUED
	WHAT SYSTEM NEEDS TO BE IN PLACE TO MONITOR MNEs?

	PCM-PowerPivot-Ghana2012_Analysis_v1
	I. Objectives:
	a. Estimate the difference between Ghana’s reported export to its partner countries (Ghana_X.xlsx) and Partner countries’ reported import from Ghana (Partner_M.xlsx)
	b. Estimate the difference between Ghana’s reported import from its partner countries (Ghana_M.xlsx) and Partner countries’ reported export to Ghana (Partner_X.xlsx)
	c. Identify top 10 or 20 high-risk countries with misinvoicing in export and import

	II. Data source: IMF DOTS, 2012 monthly.
	III. Complication:
	a. Ghana’s export list of partner countries: A, B, C, D
	b. List of Countries reported as having imported from Ghana: A, B, D, E.
	c. For Country C, Ghana reported as having exported but Country C did not report any import from Ghana
	d. For Country E, Ghana has no record of having exported to E, but E reported as having imported from Ghana
	e. To put together all the data from Ghana’s export and Partners’ import, we need to create a list of all countries: A, B, C, D, and E: Name the file as PCM_Ghana_X_Analysis.xlsx (PCM_Ghana_M_Analysis.xlsx for import analysis.) This file has only one ...
	f. Using Power Pivot in Excel, build a model relating PCM_Ghana_X_Analysis.xlsx to Ghana_X_2012.xlsx and Partner_M_2012.xlsx and create calculated fields:
	i. Export_Over_Invoiced_amount =  MAX(0, (Ghana_X – Partner_M/1.1))
	ii. Export_Under_Invoiced_amount = MAX(0,(Partner_M/1.1 – Ghana_X))
	iii. Dividing import data by a factor of 1.1 is because import data is reported as CIF while export data as FOB.

	IV. Modeling PCM using Power Pivot for Ghana Export misinvoicing
	a. Open a new Excel blank workbook. Save it as =xlsx
	(If Power Pivot is not activated, activate Power Pivot:  File > Options > Add-ins > Select “Microsoft Power Pivot for Excel” from Inactive Application Add-ins list)
	b. Click “Power Pivot” from the ribbon
	c. Click Manage
	d. To import Ghana_X_2012.xlsx data, select “From Other Sources” from “Get External Data” group
	e. You will see a list of Relational Databases. Scroll through to the bottom of the list. Select Excel File (or Text File for importing a CSV file) > Browse > & check “Use first row as column headers” > Next > Finish (name the table as Ghana_X)
	f. Repeat to import Partner_M_2012.xlsx (name the table as Partner_M) and PCM_Ghana_X_Analysis.xlsx (name the table as Ghana_X_IFF)
	g. Click “Diagram View”  in View Group
	h. Then you will see three tables
	i. At this point, three tables are not related to each other. To model the relation between Ghana_X_IFF and Ghana_X, drag the field, “Partner” from Ghana_X_IFF to “Partner” in Ghana_X. Repeat this process for Partner in Ghana_X_IFF to Reporter in Part...
	j. There should be lines linking tables. At the ends of the lines, a “*” should be on the side of Ghana_X_IFF table and a “1” on Ghana_X and Partner_M. This indicates one-to-many relations.
	k. Now click “Data View” in the View group:
	You should see a list of three tables at the bottom: Ghana_X, Partner_M, Ghana_X_IFF. Above Ghana_X_IFF, only one table heading (field name) is shown: Partner.
	Inserting Calculated Fields
	Double click the heading “Add Column” on the top right-hand side, and you can name a new field name to be calculated. Name it as Ghana_X. Add three more columns: Partner_X, Ghana_X_Over, Ghana_X_Under. Notice the calculated fields are highlighted in b...

	V. Create Pivot Table to sort by IFF amount and identify high-risk partners
	a. PivotTable dropdown menu: Select Pivot Table > Choose “New Worksheet”
	b. Select the field “Partner” from Ghana_X_IFF, then Ghana_X_ov, Ghana_X_un
	c. Select the entire pivot table and copy it.
	d. Paste it in a range somewhere below the pivot table: Click Home > Paste (down arrow) > Select “Values (V)”  from “Paste Values” group
	e. To find the list of top 10 (or 20) high risk countries with Export Underinvoicing, sort the table in descending order of Ghana_X_un.
	f. To find the list of top 10 (or 20) high risk countries with Export Overinvoicing, sort the table in descending order of Ghana_X_ov.

	VI. Modeling PCM using Power Pivot for Ghana Import misinvoicing
	For Ghana’s Import analysis, follow the same process as in “IV. Modeling PCM using Power Pivot for Ghana Export misinvoicing” and “V. Create Pivot Table to sort by IFF amount and identify high-risk partners.”
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